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WARNING:
This software was written and designed for teaching purposes. It has been tested
on several examples but not on a wide variety of data sets. For mission-critical
projects, always check the results with full-fledged statistical programs.

The Monte Carlo Simulation add-in is MCSim.xla (on the CD-ROM or zipped archive, it is in
BasicTools\ExcelAdd-In\M CSim).

PURPOSE OF THIS DOCUMENT

This document describes how to install and use the Excel add-in MCsim.xla in order to run a
Monte Carlo simulation from an Excel workbook.

INSTALLING AND LOADING
Microsoft offers the following description of an Excel add-in:

Add-ins are programs that add optional commands and features to Microsoft
Excel. Before you can use an add-in, you must install it on your computer and
then load it in Microsoft Excel. Add-ins (*.xla files) are installed by default in the
Library folder in the Microsoft Excel folder. Loading an add-in makes the feature
available in Microsoft Excel and adds any associated commands to the
appropriate menus. [Microsoft Excel Help, add-ins, overview]

Thus, to install an add-in is to have an add-in file (*.xla) in the Library folder of your hard drive.

To load it, you must complete an additional step using the Add-In Manager. Fortunately, you
need to do this only once.
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Step 1: Installing the MCSim.xla file

If you are accessing the MCSim.xla add-in from a CD-ROM, place the CD in your computer. If
accessing from a network server, make sure you can read from the appropriate network drive.

If you do not have CD-ROM or network access to the MCSim.xla add-in, download it by visiting
<www.wabash.edu/econometrics>. Download the MCSim.xla file directly to the appropriate
add-ins folder on your hard drive (usually, C:/Program Files/MicrosoftOffice/Office/Library) or
move it there after downloading to your hard drive.

Step 2: Loading The MCSim.xla add-in
A) Getting the Add-In Manager
Excel 2007 and greater
Once the MCSim.xla file is accessible, launch Excel and use the Add-In Manager to load the
Monte Carlo Simulation add-in. First, open the Add-In Manager by clicking File, then Options

in Excel 2010 or the Office button (in the top left corner), then Excel Options in Excel 2007.
Next, click Addins (as shown highlighted below) and, finally, clicking Go (near the bottom):

Excel Options

P I e = 2
s g% View and manage Microsoft Office add-ins.
Formulas
Proofing Add-ins
save Name Location Type A
Advanced . i ) ) ) )
Acrobat PDFMaker Office COM Addin C\... 8.0'PDFMakerOffice\PDFMOfficeAddin.dll  COM Add-in
Customize Adobe Contribute Plugin “\...e\/Adobe Contribute C53/OfficePlugin.dll  COM Add-in

Analysis ToolPak

Add-Ins Analysis ToolPak - VBA

Bootstrap

L&
. fice\Officel 2\Libran/\Analysis\ANALYS32.XLL  Excel Add-in
Chice\Officel 2\Libran\Analysis\atpvbaenadam  Excel Add-in
Chation Data\Microsoft\AddIns\Bootstrap.xla  Excel Add-in
Trust Center Comparative Statics Wizard Chpplication Data\Microsoft\AddIns\Cswizxla  Excel Add-in
DDV Gauss Newton C\.. lication Data\Microsoft\AddIns\DDVGN.xla  Excel Add-in
Resources Google Desktop Office Addin C:\... Desktop Search\GoogleDesktopOffice.dll  COM Add-in
Histogram Creator Ch..ation Data\Microsoft\AddIns\Histogramxla  Excel Add-in
Microsoft Office Live Add-in Chailes\Microsoft\Office Live\OLConnector.dil COM Add-in
Monte Carlo Simulation Add-in C\plication Data\Microsoft\AddIns\MCSimxla  Excel Add-in
OLS Regression C\.. Data\Microsoft\AddIns\OLSRegression.xla  Excel Add-in
P Value Calculator C:\...plication Data\Microsoft\AddIns\PValue xla  Excel Add-in
Snaglt Add-in & chSmith\3naglt 9\SnagitOfficeAddin.dll  COM Add-in
Solver Add-in Ci\. Office\Officel 2\Libran®,SOLVER\solverxlam  Excel Add-in

Conditional S5um Wizard sumif.xlam Excel Add-in

Custom XML Data . iles\Microsoft Office\Officel \OFFRHD.DLL  Document Inspector

Date (Smart tag lists) C\.iles\Microsoft Shared\Smart TagtMOFLDLL ~ Smart Tag

Dummy Dep Var Analysis C\..pplication Data\Microsoft\AddIns\DDV xla Excel Add-in

Euro Currency Tools eurotoolxlam Excel Add-in e
Add-in: Acrobat PDFMaker Office COM Addin

Publisher: Adobe Systems, Incorporated
Location: C\Program Files\Adobe\Acrobat 8.0'"PDFMaken Office\PDFMOfficeAddin.dll

Description:  Acrobat PDFMaker Office COM Addin

Manage: | Excel Add-ins vl[ GO,
|
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Excel 1997 to 2003

Once the MCSim.xla file is accessible, launch Excel and use the Add-In  'facls Data Window Help

Manager to load the Monte Carlo Simulation add-in. First, open the " anelling. . F7
Add-In Manager by clicking on the Tools menu item and selecting Add- AutoCorrect...
I
ns.
Share Workboak, ..
Track Changes 4
Add-ins i B3 [Merae Workbooks, .
Add-Ins available: Erotection 3
[ Analysis ToolPak -
[ Analysis ToolPak - YBA Cancel | Goal Seek, .
[ Autosave Scenarios
v Comparative Statics Wizard E— =
[ Conditional Sum Wizard = Auditing r
[ CE Hiskagrams
\CkDurnry Dep Yar Analysis Macro b
[ Durbin-watson Analysis |
[ File Conversion Wizard ;
™ Fitter AddIn =] CLEiEEE
) Opkions...
urnny Dep Yar Analysis
Probit and Logit Analysis (2 1an 2002)

With the Add-In Manager dialog box up, the instructions for all versions of Excel are the same.

B) Installing and Loading the MCSim.xla file

If the Monte Carlo Simulation add-in is not listed in the Add-Ins scroll box (as in the example
above), click the Browse (or Select) button, navigate to the MCSim.xla file on the CD-ROM or

network drive, select it, and click OK. Macs that run Visual Basic Note:

Some versions of OfficeX report

Microsoft Excel x| “Unable to Copy add-in to the
Add-ins folder.” This is a bug.
@ Copy MCSim.xla’ to the Addins Folder For Humberto Barreto? The add-in really is there. Simply
quit Excel, then restart it, return to
ves I No | concel | the Add-In Manager, and continue

following the instructions.

Click OK if you are asked to write the MCSim.xla file to the Addins (or Library) folder. The
Add-In Manager dialog box will now list the Monte Carlo Simulation add-in.

The Add-In Manager lists all of the installed add-ins, and those with checkmarks are also loaded.
Microsoft offers the following advice, “To conserve memory, unload add-ins you do not use
often. Unloading an add-in removes its features and commands from Microsoft Excel, but the
add-in program remains on your computer, and so you can easily load it again.” [Microsoft Excel
Help, add-ins, overview]
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Make sure to select the check box next to the Monte Carlo Simulation add-in and click OK.
Excel will load the MCSim.xla file and notify you of successful installation with the following
message:

Monte Carlo Simulation Available E|

- You hawve successfully loaded the Monte Carlo Simulation add-in. You musk have at least one cell that has a random
\IJ‘) nurmber Funckian in ks Formula, %ou provide one or bwao cells and the add-in simply recalculates the workbook For as
mary repetitions as you indicate and ouktputs the resulks in a new sheet in your workbaoak,

Click. an MCSim under the Add-ins tab {ar, in older versions, Taals: MCSim ... to begin,

USING THE MCSIM.XLA ADD-IN--ORIGINALVERSION:

Using the Monte Carlo Simulation add-in is easy. You need a spreadsheet with at least one cell
that uses a random number formula. Cell Al has formula “=RAND()”’; thus, when the sheet is
recalculated (by hitting the F9 keyl), the value of the cell (the number displayed) will change.

A - & =RAND() A3 - A =IF(A1>0.910)
A BE | © | D | Afterhitting F9 A | B | © | D
1 | 0.617718 » 1 | 0.926507
2 2
3] N —|
4 4
5] 5|

Notice that the spreadsheet can have cells that depend on other cells. Cell A3 uses an IF
statement based on the random draw resulting from cell Al, “=IF(A1>0.5,1,0)”. Thus, A3’s
value will be either 1 or 0, as determined by the value of Al. The Monte Carlo Simulation add-
in can be used on cell A3 even though it does not have a random number in its formula because
A3 is based on Al.

To run a Monte Carlo simulation, simply click on the Add-ins tab, in Excel 2007 or greater, or
the Tools menu item in earlier versions, and select the MCSim item to access a dialog box that
controls the simulation.

The active cell (the last cell clicked by the user) appears by default in the Select a cell box. If
this is not the cell you want to use, simply click in the Select a cell box and click on the desired
cell.

The Choose RNG option enables you to use either Excel’s built-in random number generating
function RAND or Barreto-Howland’s RANDOM algorithm (packaged with this add-in). If you
select the All RANDOM option, every occurrence of RAND will be replaced by RANDOM.

' On Macintosh computers that run Visual Basic, hit the Command (clover) and equals sign keys simultaneously
instead of the F9 key. On PCs, CTRL-= will also recalculate cells in the workbook.
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To run a Monte Carlo simulation of two cells, click in the Select a second cell box and then click
on a cell in the worksheet. The screenshot below shows the options;

Monte Carlo Simulation

Requirved
Zelect acell

| $as1

Enter the Mumber of Eepetitions

1000

Choose BN G

{* Mo Changes
" AN EAND

" AN RaNDOM

Cancel

-

Optional
Zelect a second cell

N

[ Recalrilate the Entive Workbaok ™. Click here
to make the
[ Fecord All Selected Cells dialog box
[~ Crutput ta Existing MCSim Sheet collapse so
you can see
[ Delete Previons MCSim Sheet the sheet.

Tat Saed | | Trap Emor

Progress Bar

Click Proceed to run the simulation. Use the Progress Bar to gauge how long it will take to
finish the simulation. You may use other programs while the simulation is running, but doing so
may slow Excel down. You can always hit the Escape (ESC) key (on the top left corner of most
keyboards) to kill the simulation. Click End when prompted. The add-in runs faster if no other
Excel workbooks are open.

Excel recalculates your worksheet for as many repetitions as indicated and stores the value of the
cell (or both cells) after each calculation. The results are then presented in a new worksheet in

your workbook.
Results of Monte Carlo Simulation

Sample Sheetl!$SAS

Number
1

=B e NV N N I )

10
11
12
13
14
15
16
17
18
19
20

MCSim

1
0.423
0.421
0.146
0.202
0.871
0.322
0.723
0.247
0.270
0.769
0.557
0.429
0.131
0.038
0.426
0.174
0.554
0.300
0.268
0.654

Simulation
Stats

1000

repetitions

1

seconds

Notes

Summary Statistics
Average 0.495
SD 0.2881
Max 0.999
Min 0.000

Histogram of Sheet1!$A$1

Histogram bins

0.2 0.4 0.6

0.8

include the left
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endpoint but not
the right.




Results for a two variable simulation look like this:

Results of Monte Carlo Simulation

Sample  Sheetl!$ Sheetl!$

Number ~ AS$I AS$2 Simulation Stats
1 0.514 0.722 1000(repetitions
2 0.059 0.644 1]secs Sheetl!$AS$1 Sheetl!$A$2 Notes
3 0.076 0.356 Average 0.501]Average 0.492
4 0.291 0.922 SD 0.2875|SD 0.2934
5 0.852 0.996 Max 1.000]Max 1.000]
6 0.942 0.598 Min 0.002|Min 0.001
7 0.282 0.502 .
3 0083 0323 Histogram of Sheet1!$A$1 And Sheet1!$A$2
A s
1 0852 0.570 ~— Shieet1 5A%2
12 0.533 0.518 D:Ij
13 0.227 0.637
14 0.226 0.583
15 0.773 0.468
16 0.688 0.936
17 0.703 0.445
18 0429 0.380 ‘ ‘ ‘ ‘
19 0.487 0.956 0 0.2 0.4 0.6 0.8 1
20 0.850 0.876

The new spreadsheet in your workbook is alive—you can change the scale, title, and legends on
the graphs, change labels and colors on the cells in the spreadsheets, and add descriptive
information as needed. The data underlying the graph are available by scrolling right.

You can run as many Monte Carlo simulations as you want by simply returning to your original
worksheet and executing Tools: MCSim. Delete unwanted results by simply deleting the sheet.

The Recalculate the Entire Workbook Option

If you have a complicated data generation process that spans several sheets in a workbook, be
sure to choose the option to Recalculate the Entire Workbook. This forces a recalculation of all
of the sheets in the workbook, instead of just the active sheet. You can track cells in other sheets
by collecting all of the cells to be tracked on a single sheet.

If your model is implemented in a single sheet, you need not check this option. Excel will
recalculate only the single sheet you are working on. This saves time in running the Monte Carlo
simulation if you have many formulas in other sheets in the workbook since Excel does not
recalculate those formulas.

Testing has shown that, for simple workbooks (with few formulas in other sheets), recalculating
the entire workbook is faster than recalculating a single sheet.
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The Record All Selected Cells Option

You might want to track more than two cells or see all of the simulation results (instead of just
the first 100). The Monte Carlo simulation add-in allows you to track up to 256 variables
(including one or two you selected for histogram display) and see results for up to 65,000
repetitions.

To take advantage of this, you must first select the cells you want to record (using the CTRL
key, as usual, to select noncontiguous cells), then execute Tools: MCSim and, finally, check the
Record All Selected Cells option. By checking the Record All Selected Cells option, the add-in
will track all cells that were selected before you executed Tools: MCSim and brought up the
Monte Carlo Simulation dialog box. The add-in inserts a new worksheet in your workbook and
shows ALL of the values generated by the Monte Carlo simulation. You can use this
information to sort the results in order to find percentiles (e.g., to approximate the chances of
values falling in a particular interval) and to track more than just one or two cells.

The results generated by the Record All Selected Cells option are in “raw” form. You will need
to compute averages, SDs, and draw histograms on your own. You can see the full set of
simulation results for any cell (including one that was chosen as a tracked cell) by simply
selecting that cell before executing Tools: MCSim.

To practice using this option, select cells A1 and A3 (with Al’s formula “=RAND()” and A3’s
formula “=IF(A1>0.5,1,0)") by clicking on cell Al and then holding down the CTRL key while
clicking on cell A3. Next, execute Tools: MCSim. Make one of the tracking cells Al and the
other A3. Make sure to check the Record All Selected Cells option. Click Proceed.

The Monte Carlo simulation add-in inserts two sheets in your workbook. One reports summary
statistics and draws a superimposed histogram, the other simply lists all of the simulation results
for both variables. You can confirm that the average, SD, max, and min are the same by
computing these statistics in your MCRaw sheet.

The Output to Existing Sheet Option

If you are doing repeated simulations and have set up calculations based on the simulation
results, you may want to output the results to an existing MCSim sheet rather than creating a new
sheet each time a Monte Carlo is run. Check the Output to Existing MCSim Sheet option to do
this. Instead of creating a new MCSim sheet, output is placed in the usual way (i.e., first 100 in
column B, summary statistics in range J5:J8 [and L5:L8 if two cells are tracked], and a
histogram) in a previously created MCSim sheet.

Be careful in using this option because existing simulation results are overwritten and cannot be

recovered. You can copy the existing MCSim sheet (Edit: Move or Copy Sheet...) if you want
to preserve results from a previous simulation.
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Delete Previous Sheet Option

Select this option to delete the previous MCSim sheet. This option is handy when you are
running many different experiments and are not interested in saving the results. This frees you
from having many MCSim sheets pile up in the workbook. Needless to say, use this option with
caution—there is no warning. The previous sheet is deleted and cannot be recovered.

Set Seed Option

The Set Seed input box allows you enter a number, such as 12345, that is used as a starting value
for the random number generator. You can then replicate exactly a particular simulation. Anyone
who uses the same seed (e.g., your students) will also exactly replicate your results.

This option can be used only with our user-defined RANDOM)() function. It cannot be
used with Excel’s RAND() function. The seed value is used as the first lagged value and
zero is used as the second lagged value. In addition, the first value in an array of 25
possible values is used as a multiplicative coefficient. The bottom line is that the random

numbers produced are much less random and this option should be used only for testing
and teaching.

Because the set seed option requires RANDOMY(), it automatically replaces all instances
of RAND() on your sheet with RANDOM(). To change back to RAND(), simply choose
the All RAND option and clear the Set Seed input box.

Clear the Set Seed input box to get the maximum performance out of the
RANDOM() function.

Trap Error Option

This option stops the simulation when an error is an encountered (such as dividing by zero or
inability to invert a matrix). The sample that generated the error can then be inspected.
Additional Functions

The MCSim.xla add-in is packaged with two array functions for drawing correlated, normal
random variables:

=BiVarNormal(meanl, SD1, mean2, SD2, rho)
=MultivarNormal(nvars, corrRange, meansRange, SDsRange)
Although we do not use these functions in the introductory text, they are essential for advanced

work.
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We briefly describe these functions and recommend that the interested reader go to the
CorrelatedRVs sheet in Random.xlIs (in the Basic Tools folder) for more documentation.

For the BiVarNormal function, select a horizontal pair of cells (e.g., A1 and B1), then enter the
function in the formula bar. For example, =BiVarNormal(0,1,0,10,0.9). Press CTRL-SHIFT-
ENTER to enter the array function. The values in the two cells reflect the means, SDs, and
correlation coefficient you requested. The precise order of the arguments in the function is as
follows: (Mean first variable, SD first variable, Mean second variable, SD second variable,
Correlation coefficient). You can select the two cells and drag them down to create a data set of
correlated, normal random variables.

The MultiVarNormal function enables creation of deviates drawn from a multivariate (3 or more
random deviates) normal distribution with given means and SDs and a matrix of correlation
coefficients. (The upper limit for a single sheet is 256 correlated normals, but the function
operates slowly with many correlated random variables and we are not sure how well the
Cholesky decomposition works with large correlation matrices.) The Range inputs in the
function are cell ranges (such as, C3:E5) where appropriate information has been entered.

You can use the Monte Carlo simulation add-in to confirm that the variables are operating as

expected.
A | B T C 1] D [ E [ F T G 1] H [
33 |Using the BiVarNormal and MultiVarNormal functions:
34
35 |Run MCSim.xla on the Output Testing cells to see that they match the user input.
36
37 |BiVarNormal MultiVarNormal
38 corrRange meansRange |SDsRange
39 [{=BiVarNormal(0, 1, 0, 2, 0.9)} 1 0 1
40 0.9 1 10 1
21 0.1 0.5 1 20 1
42
43
44 Ix1 x2 x1 X2 x3
451 0.781258 1.311356 0.7337286 10.06633 18.95421
46 1-0.065111 0.346686 1.5275384 10.61138 18.69332
471-1.411813 -0.957184 0.3517804 10.5471 20.75431
481 0.085173 -1.19341 0.4843857 10.79606 20.9997
491-1.067817 -1.551769 -0.9046887 9.335713 20.52788
50] 0.811482 -0.39271 -1.41555 8.27943 19.14925
51]-2.281579 -6.90773 -1.4945867 8.654316 19.57414
52] 0.912689 1.219653 0.3704282 10.27431 19.90485
53] 0.883143 2.769886 1.3295755 11.41299 19.84843
54| -1.02993 -2.755278 0.9268079 10.92419 20.40962
55 -0.5748064 9.119637 19.04451
56 -0.3723905 9.958537 20.7606
57 0.1674377 9.864947 19.58345
58
59 |Output Testing Output Testing
60 r 1 0.086896939] 0.938454
61 0.9195171 1 9.988071837| 0.887641
62 -0.0171518] 0.351143 1] 19.86186753] 0.742657

Source: [Random.xIs]CorrelatedR Vs.
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The BiVarNormal output was created by using =BiVarNormal(0, 1, 0, 2, 0.9) in columns A and
B of rows 45 to 54.

The MultiVarNormal output has the formula,
=MultivarNormal(3,$E$39:$G$41,$H$39:$H$41,$1$39:$I$41), in each row.

ERRORS AND TROUBLESHOOTING
The Monte Carlo Simulation add-in has a few simple error checks.

It will complain if you attempt to do a Monte Carlo analysis of a cell that is not a formula:

Q The selected cell does nok conkain a formula so the cell value will not change, Please try
again,

Clicking on the cell to be analyzed is better than typing it in because you might make a mistake
entering the address. If you enter, for example, “=$AS$,” you will obtain

Microsoft Excel X

Wour entry, $4% | is not a valid cell address. Please trw again.

The add-in checks to make sure the cell you selected for analysis changes when the sheet is
recalculated. If not (e.g., the cell address is valid and cell Al contains the formula, “=5"), you
will get

Cell Doesn't Change Error x|
Q The cell vou selected, [Bookl ]Sheet11$4$1, does not change when the sheet is

recalculated. This cell is not appropriate for 8 Monke Catlo analysis and no oukbput will be
generated. Please try again.

MCSim Page 10 of 11



Finally, if you check the Record All Selected Cells option and have selected more than 256 cells
to record or ask for more than 65,535 repetitions, there will not be enough room on the sheet.
The maximum size of an Excel spreadsheet is 216, or 65,536, rows by 2”8, or 256, columns.
Thus, the add-in will display a warning like this one:

Too Many Reps ﬂ

¥ou cannak have mare than 65,535 repetitions when the Record all Selected Cells option
iz on because the results will not fit on the sheet, Please lower the Mumber of

Repetitions below 65,535,

These limitations no longer apply to Excel 2007 and greater. With the latest
version of the MCSim add-in and Excel 2007 or greater, you may track as
many cells and run as many repetitions as your computer memory allows.

THIS VERSION
The latest MCSim.xla version is 10 June 2010.

To check the date of your installed add-in, in Excel 2010, execute File>Options—> Add-ins, in
Excel 2007, Office button>Excel Options—> Add-Ins, or Tools: Add-ins, in older versions. Click
on the add-in to see the date is displayed at the bottom.

To install this add-in for the first time, please follow the instructions starting on the first page of
this document.

To install over a previous version that is already installed, please see
InstallingAddinOverPreviousVersion.doc for detailed instructions. The procedure is basically this:

To install over a previous version, quit Excel and simply drag this new version into the Excel
Add-ins folder. If you do not know where this folder is, search for “DDV.xla” and then drag the
new version over the old one. Of course, you will want to accept rewriting over the previous
version. Launch Excel and you are ready to use the add-in.

ADDITIONAL HELP AND FEEDBACK:

If something goes wrong in the installation or loading process, an unexpected error keeps
recurring, or you have other problems, please contact us. Many problems are fixed by
uninstalling (unchecking in the Add-ins Manager, clicking OK) and reinstalling. We are
interested in your comments, suggestions, or criticisms of the DDV .xla software.

www.wabash.edu/econometrics

Humberto Barreto Frank Howland
DePauw University Wabash College
hbarreto @depauw.edu howlandf@wabash.edu
(765) 658-4531 (765) 361-6317
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